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This document is provided solely for the purpose of building your own personal machine.
You are welcome to read it for educational use only. Any commercial use of this document is
strictly prohibited. Copying any part of this project (including photos, videos, or plans) is not
allowed without prior permission from me.

LM42P cannot be held responsible for any malfunction of the machine that may result in
injury. You use this machine entirely at your own risk and responsibility.

Below you will find information on how to obtain an LM42P. Currently, two variants are
available:

• M1

• M2

Before you begin building your machine, please take note of the following important infor-
mation :

• For the 3D-printed parts, all files are located in the directory named 3d-print-files,
which is inside the parent directory named after the corresponding part.

• All part names are marked in bold.

• Apply threadlock to the screws.
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12 CHAPTER 1. M2

1.1 housing

Figure 1.1: m2 housing parts

1.1.1 Parts list

Table 1.1: Parts list of housing

Qty Part Description Material
1 u 10x35x250 aluminium
1 sheet 86x305x2 aluminium
1 motor sheet 86x305x2 aluminium
4 stop 13.7x33x4 aluminium
3 spacer see section spacer -
10 rivet 2.4 x 8 mm aluminium

1.1.2 sheet

This section describes the manufacturing process for the part called sheet.

Drawing

See Figure 1.2, page 13.
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Required Tools and Components

Below is the list of materials required to produce the part named sheet.

• 1x sheet dimensions : 86x305x2 material : aluminium ;

• 1x steel rule ;

• 1x file ;

• 1x drillator see section drillator 1.1.5, p. 20 ;

• 1x drillator-m see section drillator-m 1.1.6, p. 22 ;

• 4x clamp ;

• 2x 2.5 mm drill bit ;

• 1x 4.2 mm drill bit ;

• 1x 5.2 mm drill bit ;

• 1x chamfering tool ;

• 1x drill press.

Manufacturing Instructions

1. use a file to remove all sharp edges ;

2. carefully determine which face requires protection before proceeding ;

3. align and clamp the drillator-m, using the top-left corner as a reference, this is important
for proper alignment ;

4. center punch all holes using a 2.5 mm drill bit ;

5. remove the drillator-m ;

6. using the same drill bit, drill the two holes positioned at the far-left edge, one at the
uppermost and one at the lowermost position ;

7. using two 2.5 mm drill bits, align and clamp the drillator ;

8. center punch all holes ;

9. remove the drillator ;

10. drill all holes ;

11. chamfer all holes (use a screw to check the chamfer depth) ;

12. use a file to create both R 2.5 mm radii ;

13. remove the protective film or masking.
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1.1.3 motor-sheet

This section describes the manufacturing process for the part called motor-sheet.

Drawing

See Figure 1.3, page 15.
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Figure 1.3: Drawing of the motor-sheet part

Required Tools and Components

Below is the list of materials required to produce the part named motor-sheet.

• 1x sheet dimensions : 86x305x2 material : aluminium ;

• 1x flat/convex file ;

• 1x drillator see section drillator 1.1.5, p. 20 ;

• 1x drillator-m see section drillator-m 1.1.6, p. 22 ;

• 1x scribe ;

• 4x clamp ;
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• 2x 2.5 mm drill bit ;

• 1x 4.2 mm drill bit ;

• 1x 5.2 mm drill bit ;

• 1x jigsaw ;

• 1x chamfering tool ;

• 1x drill press.

Manufacturing Instructions

1. use a file to remove all sharp edges ;

2. carefully determine which face requires protection before proceeding ;

3. align and clamp the drillator-m, using the top-left corner as a reference, this is important
for proper alignment ;

4. using a scriber, mark the outline of the 38 mm diameter hole ;

5. center punch all holes using a 2.5 mm drill bit ;

6. remove the drillator-m ;

7. using the same drill bit, drill the two holes positioned at the far-left edge, one at the
uppermost and one at the lowermost position ;

8. using two 2.5 mm drill bits, align and clamp the drillator ;

9. center punch all holes ;

10. remove the drillator ;

11. drill all holes ;

12. chamfer all holes (use a screw to check the chamfer depth) ;

13. use a file to create both R 2.5 mm radii ;

14. using a jigsaw, cut as close as possible to the 38 mm diameter outline ;

15. Using a flat/convex file, file the 38 mm hole until the motor fits through ;

16. remove the protective film or masking.

1.1.4 u

This section describes the manufacturing process for the part called u.

Drawing

See Figure 1.4, page 17.



1.1. HOUSING 17

7,5

45,57

7,5

34,43

25

72,5

75 35

105

3,36x O

305

2,5
10

x 
O

Figure 1.4: Drawing of the u part



18 CHAPTER 1. M2

Required Tools and Components

Below is the list of materials required to produce the part named u.

• 1x square tube dimension : 35x35x2x305 material : aluminium ;

• 1x gauge minimum length: 305 mm ;

• 1x try square ;

• 1x steel rule ;

• 1x scriber ;

• 1x hand saw ;

• 1x perpendicaltor ;

• 1x file ;

• 1x rail (see section linear-guide 1.2, p. 26) ;

• 2x clamp ;

• 1x 3.5 mm drill bit ;

• 1x 3.3 mm drill bit ;

• 1x 2.5 mm drill bit ;

• 1x chamfering tool ;

• 1x drill press.

Manufacturing Instructions

1. scribe a line with a scriber, leaving approximately 0.3 mm of extra material beyond the
final total length ;

2. cut the square tube to length using a handsaw and a try square ;

3. use the perpendiculator to ensure both ends are square ;

4. scribe two lines using the scriber, each about 0.3 mm from the edge of the squared
square tube ;

5. cut the square tube along the scribed lines using the handsaw ;

6. use a file to clean the cuts and chamfer the edges ;

7. clamp the rail in the correct position using a gauge (make sure it’s centered), see
Figure 1.5, page 19 ;
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8. mark the positions of the six 3.3 mm holes using a 3.5 mm drill bit to center punch ;

9. drill the six holes using a 3.3 mm drill bit (do not drill the 2.5 mm holes yet—those
will be drilled with the sheets) ;

10. chamfer the six holes using a chamfering tool ;

11. clamp the sheet in place ;

12. center punch the five holes using a 2.5 mm drill bit ;

13. clamp the motor sheet ;

14. center punch the five holes using a 2.5 mm drill bit ;

15. drill all ten holes using a 2.5 mm drill bit ;

16. chamfer the six holes using a chamfering tool.

1.1.5 drillator

This section describes the manufacturing process for the part called drillator.

Remark : If your 3D printer has a large enough build volume, you can print the drillator
and drillator-m in one piece, which improves alignment accuracy.

Drawing

See Figure 1.6, page 21.
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Required Tools and Components

Below is the list of materials required to produce the part named drillator.

• 1x 3d printer ;

• 1x PLA ;

• 1x file ;

• 1x drill ;

• 1x 2.5 mm drill bit.

Manufacturing Instructions

1. 3D print the part using the files located in the 3d-print-files directory ;

2. chamfer the edges using a file ;

3. drill the 2.5 mm holes using a 2.5 mm drill bit and a drill.

1.1.6 drillator-m

Remark : If your 3D printer has a large enough build volume, you can print the drillator
and drillator-m in one piece, which improves alignment accuracy.

Drawing

See Figure 1.7, page 23.
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Required Tools and Components

Below is the list of materials required to produce the part named drillator.

• 1x 3d printer ;

• 1x PLA ;

• 1x file ;

• 1x drill ;

• 1x 2.5 mm drill bit.

Manufacturing Instructions

1. 3D print the part using the files located in the 3d-print-files directory ;

2. chamfer the edges using a file ;

3. drill the 2.5 mm holes using a 2.5 mm drill bit and a drill.

1.1.7 stop

Drawing

See Figure 1.8, page 24.

glue

nut

screw

Figure 1.8: Drawing of the stop

Parts list

Table 1.2: Parts list of housing/stop

quantity name specification material
4x1=4 screw M4 × 6 mm Torx flat head screw stainless steel
4x1=4 nut standard M4 hex nut stainless steel

- glue black Poliflex 444
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1.1.8 spacer

Drawing

See Figure 1.9, page 25.

screw
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Figure 1.9: Drawing of the spacer

Parts list

Table 1.3: Parts list of housing/spacer

Qty Part Description Material
3x2=6 screw M5 × 12 mm Torx flat head screw stainless steel
3x1=3 spacer M5 x 8 x 35 mm aluminium
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1.2 linear guide

Figure 1.10: m2 linear guide parts

1.2.1 Parts list

Table 1.4: Parts list of linear guide

Qty Part Description Material
1 rail MGN12H, length: 250 mm -
1 slider MGN12H, 27 x 45.4 mm -
6 rivet 3.2 x 10 mm aluminium

1.2.2 Drawing

See Figure 1.11, page 27.
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1.3 block

Figure 1.12: m2 block parts

1.3.1 Parts list

Table 1.5: Parts list of block

Qty Part Description Material
1 junction block 3D printed nylon
1 glue casted epoxy
2 male junction google : pool cue junction brass
1 belt HTD 3 -
1 clamp HTD 3 aluminium
1 stop subassemblie (see section) see section stop
4 screw M3 × 36 mm flat head screw stainless steel
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1.3.2 junction block

Drawing

See Figure 1.13, page 30.
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Required Tools and Components

• 1x 3D printer ;

• 1x nylon filament ;

• 1x STL file ;

• 2x male junction ;

• 1x file ;

• 1x gauge ;

• 4x screw (M3, length=36mm) ;

• 1x alignator ;

• 1x glue ;

• 2x rods ;

• 2x elastic ;

• 1x hot glue.

Manufacturing Instructions

1. 3D print the junction block using the STL file and nylon filament.

2. File a flat surface of 8.5 x 13 mm on the threaded M10 part (on both junction block.

3. Mount the junction block on the alignator (slider) with the spacer and the four
screw-3x.

4. Insert a male junction on each end of the rod.

5. Place the slider on the rail and both rods on the v.

6. Attach using two elastic bands.

7. Press the rods against the junction block.

8. Fix them in place with hot glue. See Figure 1.14, page 32 and Figure 1.15, page 32.
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Figure 1.14: male junction aligning

hot glue

spacer

rods

Figure 1.15: male junction aligning zoomed
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9. Test the seal by blowing into the hole of the junction block.

10. Prepare the glue1:

(a) Quantity hardener: 2 g ;

(b) Quantity resin: 5 g ;

(c) Quantity graphite powder: 1.5 g.

11. Pour the mixture into the junction block.

12. Cure for 24 hours at 20°C or 4 hours at 40°C.

13. Remove the hot glue.

14. Remove the four screw-3x and the spacer.

1Adjust the quantity of resin and hardener according to the type of glue used.
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1.3.3 belt

Drawing

See Figure 1.16, page 34.

total length = 603mm
15

Figure 1.16: Drawing of the belt

Required Tools and Components

• 1x roll of belt standard HTD-5M ;

• 1x double meter ;

• 1x scissors.

Manufacturing Instructions

1. Cut a belt with a length of 603 mm .
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1.3.4 clamp

Drawing

See Figure 1.17, page 35.
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Figure 1.17: Drawing of the clamp

Required Tools and Components

• 1x clamp standard ;

• 1x 3D printer ;

• 1x PLA filament ;

• 1x STL file ;

• 1x drillator ;

• 2x clamp ;

• 1x scriber ;

• 1x file ;
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• 1x 2.5 mm drill bit ;

• 1x 3 mm drill bit ;

• 1x chamfer mill ;

• 1x driller ;

• 1x drill press ;

• 1x gauge.

Manufacturing Instructions

1. 3D print the drillator using the provided STL file and PLA filament.

2. Clamp the drillator onto the clamp standard.

3. Scribe the outer dimensions.

4. Center punch the four holes.

5. Mill or cut the shape to size using a handsaw, according to the Drawing section.

6. Chamfer all sharp edges.

7. Drill the four holes using a 3 mm drill bit.

8. Chamfer all four holes: 1× 45◦.
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1.3.5 screw

These screws are used to assemble the stop, belt, clamp, and junction block onto the
slider. Initially, the exact screw length cannot be determined. The objective is to ensure that
the threaded portion engages as much as possible with the slider, so the screw holds securely.

Drawing

See Figure 1.18, page 37.

determine first the length
before cuting it.

36? ?

3
M

screw screw standard

40

3
M

Figure 1.18: Drawing of the screw

Required Tools and Components

• 4x screw standard (M3, length = 40 mm) ;

• 1x junction block ;

• 1x belt ;

• 1x clamp ;

• 1x depth gauge ;

• 1x handsaw ;

• 1x file ;
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• 1x gauge ;

• 1x Phillips screwdriver ;

• 1x bench vise.

Manufacturing Instructions

1. Place the belt between the clamp and the junction block.

2. Use a screw-40 to loosely secure the belt and the junction block onto the slider.
Tighten the screw until it reaches the end of the internal thread in the slider.
Warning: It’s normal if the junction block is not fully tightened—this screw is slightly
too long.

3. Using a depth gauge or ruler, measure how much of the screw needs to be cut off.

4. Cut the screw standard to the correct length using a handsaw.
Tip: Use a bench vise to hold the screw steady while cutting.
Deburr the end with a file for a clean finish.

5. Based on the first test, the ideal screw length is approximately 36 mm.
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1.3.6 stop

Drawing

See Figure 1.19, page 39.
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Figure 1.19: Drawing of the stop parts

Parts list

Table 1.6: Parts list of block/stop

quantity name specification material
1 stop 14 x 4 x 33 aluminium
4 washer (2 spacer) 3.2 x 7 x 0.5 stainless steel
2 screw M3 × 8 mm Torx flat head screw stainless steel
1 glue - Poliflex 444

Required Tools and Components

• 1x 14 x 33 aluminium sheet thickness 4 mm ;

• 2x clamps ;
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• 1x scriber ;

• 1x drillator ;

• 1x mill ;

• 1x file ;

• 1x 2.5 mm drill bit ;

• 1x 3 mm drill bit ;

• 1x chamfer mill ;

• 1x driller ;

• 1x drill press.

Manufacturing Instructions

1. Mill or file the stop (using the tool drillator) according to the dimensions shown in the
Drawing ;

2. Using the shaped tool drillator, drill both holes ;

3. Drill and chamfer the two 3 mm holes .

1.3.7 Assembling Instructions

Required Tools and Components

• 1x glue pistol ;

• 1x glue ;

• 1x Torx screwdriver ;

• 4x washer (2 spacer) ;

• 1x threadlocker.

1. Apply threadlocker to the four screw.

2. Secure the belt using the clamp and the four screw-3x onto the slider.

3. Apply mastic glue to the stop.

4. Ensure the two spacers are in place.

5. Apply threadlocker to the screws.

6. Fasten the stop onto the clamp.

7. Allow to cure for 24 hours.
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1.3.8 alignator

The purpose of this tool is to align the male junction inside the junction-bloc during
glueing. The male junction is screwed in the rod the latter is placed on the v.

Assemblies In the figure 1.20, page 42 we can see the alignator fully assembled with
it’s components.
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spacer

rail

v

Figure 1.20: alignator assembled

Roadmap This paragraph shows how to build the alignator.
It’s not necessary to follow straight all these points one after another, but I think it’s the

most logical to do it in these steps I thinks :

1. prepare all stuff in the Parts list with the tools showed in the Tools list ;

2. assemble the alignator.

Parts list In this pargraph we can find the whole list of parts that the perpendiculator
needs, like :

• 1 x rail ;

• 4 x spacer ;

• 1 x PLA (3d printing).

Tools list In this paragraph we can find the list of tools that we need to build the
alignator, like :

• 3d printer ;

• torks screwdriver.
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Shaped-parts In this paragraph we can find the shaped parts that the alignator re-
quires, like :

• spacer ;

• v.

spacer

This paragraph show how to build the spacer.

Drawing The figure 1.21, page 44, show the drawing of the spacer.
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Figure 1.21: spacer drawing for alignator

Quantity 4 ;

Material PLA 3d printed.

Roadmap

1. copy the file named UM2 spacer.gcode from the 3d-print-files folder to the 3d
printer ;

2. print the 4 spacer with a 3d printer.

v
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This paragraph show how to build the v.

Drawing The figure 1.22, page 45, show the drawing of the spacer.

26 10

12

20

Figure 1.22: v drawing for alignator

Quantity 4 ;

Material PLA 3d printed.
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Roadmap

1. copy the file named UM2 v.gcode from the 3d-print-files folder to the 3d printer ;

2. print the 4 v with a 3d printer.
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1.4 motor

Figure 1.23: m2 motor parts

1.4.1 Parts list

Table 1.7: Parts list of motor

Qty Part Description Material
1 motor Nema 23 4.2A 3N.m 112mm with cable
1 pulley HTD M3 28T 16/8 aluminium
2 spacer M5 x 8 x 35 mm aluminium
2 spacer screw M5 × 65 mm Torx flat head screw stainless steel
2 screw M5 × 12 mm Torx flat head screw stainless steel
4 nut M5 stainless steel

1.4.2 Drawing

See Figure 1.24, page 48.
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Figure 1.24: Drawing of the motor parts
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8

1,5

spacer

Figure 1.25: Position of the pulley on the motor shaft

1.4.3 Assembling Instructions

Required Tools and Components

• 1x motor ;

• 1x pulley ;

• 1x spacer ;

• 1x adjustable reamer, diameter 8 mm ;

• 1x sandpaper ;

• 1x acetone.

• 1x shaft glue (Loctite 238) ;

1. Test the pulley on the motor shaft.
There should be a slight gap between them (for the shaft glue).

2. If there is no gap :

• Use an adjustable reamer (diameter 8 mm) to carefully enlarge the hole in the
pulley until the pulley fits with a slight gap.

3. Clean the shaft and the pulley with acetone.

4. Apply shaft glue to the shaft.

5. Press the pulley onto the spacer, using a spacer to ensure correct positioning (See
Figure 1.25, page 49.

6. Let it cure for 4 hours.
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1.5 idle pulley

Figure 1.26: m2 idle pulley parts

1.5.1 Parts list

Table 1.8: Parts list of idle pulley

Qty Part Description Material
1 idle pulley HTD3 28T / 8 Aluminium
2 screw M5 × 12 mm Torx flat head screw stainless steel
1 spacer M5 x 8 x 35 mm Aluminium

1.5.2 Drawing

See Figure 1.27, page 51.
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Figure 1.27: Drawing of the idle pulley parts
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1.5.3 Assembling Instructions

Required Tools and Components

• 1x idle pulley ;

• 1x spacer ;

• 1x depth gauge ;

• 1x shaft glue (Loctite 238) ;

• 1x sandpaper ;

• 1x driller ;

• 1x M5 threader shaft ;

• 1x acetone.

1. Test the idle pulley on the spacer.
There should be a slight gap between them (for the shaft glue).

2. If there is no gap :

• Insert the threaded shaft into the spacer and mount it in a drill.

• Use sandpaper to carefully reduce the outer diameter of the spacer until the idle
pulley fits with a slight gap.

3. Clean the spacer and the idle pulley with acetone.

4. Apply shaft glue to the spacer.

5. Press the idle pulley onto the spacer, using a depth gauge to ensure correct positioning
(see position Drawing).

6. Let it cure for 4 hours.
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1.6 attachment

Figure 1.28: m2 attachment parts

1.6.1 Parts list

Table 1.9: Parts list of attachment

Qty Part Description Material
1 plate 57 x 57 x 6 aluminium
1 stop nut 3D Printed PLA
1 nut M8 brass
1 washer M8 x 8 x 35 mm stainless steel
4 spacer 8 / 5 × 10 mm aluminium
2 screw M5 x 18 mm Torx flat head screw stainless steel
1 grip 57 x 57 Griptape (skateboard)
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1.6.2 Drawing

See Figure 1.29, page 54.
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Figure 1.29: Drawing of the attachment parts

1.6.3 Manufacturing Instructions

Required Tools and Components

• 1x aluminium plate 57 x 57 x 6 mm ;

• 1x 3D printer ;

• 1x PLA ;

• 1x STL file (stop nut) ;

• 1x STL file (drillator) ;

• 2x clamp ;

• 1x scriber ;

• 1x file ;
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• 1x 2.5 mm drill bit ;

• 1x 5.2 mm drill bit ;

• 1x 4.2 mm drill bit ;

• 1x 9 mm drill bit ;

• 1x M5 tap ;

• 1x Griptape 57 x 57 mm (use for skate board) ;

• 1x drill press ;

• 1x driller.

1. 3D print the drillator ;

2. 3D print the stop nut ;

3. clamp the drillator on the aluminium plate ;

4. scribe the 4x radii and the holes ;

5. drill and tap all holes ;

6. file the 4 radii ;

7. file the sharp edges ;

8. cut and drill the grip.

1.7 Assembling Instructions

Remark All screws must be glued using threadlock glue.

1. Fabricate the shaped tools: the tensionator and the drillator (refer to section ten-
sionator and drillator).

2. Rivet the rail onto the housing U-profile.
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rail

housing u profile

rivet 32

3. Slide the junction block (assembly) onto the rail.
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junction bloc (assemblie)

4. Mount the stop screw nut, ensuring proper alignment. Glue with threadlock glue
and mastic glue. After curing, file the 5x screw so it does not protrude.

housing sheet

screw 5x
nut 4
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90
°90°

5. Repeat the previous step to mount the second stop screw nut.
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nut 4

housing motor sheet

screw 5x
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90° 90
°

put some
mastic
glue
here

put some
mastic
glue
here

6. Assemble the following components:

• 3 × spacer 35

• 3 × screw 12

• 4 × spacer 10

• 2 × screw 18

• 1 × stop nut

• 1 × nut 8

• 1 × washer 8

• 1 × plate
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screw 12

spacer 35t

screw 18

spacer 10

plate

washer 8

stop nut

nut 8

7. Rivet the following:

• 5 × rivet 24
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rivet 24

8. Secure the motor (assembly) with:

• 2 × screw 12
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• 2 × washer 5

• 2 × nut 5

Ensure the cable is properly oriented.

motor (assemblie)

nut 5
washer 5

screw 12

watch out the cable position
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9. Close the housing using the idle pulley (assembly), with:

• 2 × screw 65

• 2 × spacer 35

• 2 × washer 5

• 2 × nut 5

• 3 × screw 12

• 5 × rivet 24

• 1 × idle pulley (assembly)

screw 65

spacer 35

screw 12

nut 5

washer 5

rivet 24
idle pulley
(assemblie)
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10. Attach the shaped tool tensionator to the idle pulley using 2 × colson 4.

4

tensionator

11. Place a weight of approximately 17 kg (e.g., 11 × 1.5 L bottles).
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12. Mount the shaped tool drillator.

A

DETAIL A

O
8

drillator

13. Mark drill points using a 2.5 mm drill on both sheets.

14. Drill with a 5 mm drill, then chamfer the holes. Test the depth using a screw.

15. Tighten the idle pulley using 2 × screw 12.

16. Well Done you’ve finished the m2 !

1.7.1 drillator

This section shows how to make the shaped tool named drillator The purpose of this tool is
to point the holes of the idle pulley shaft during tensioning the belt.

Drawing

The figure 1.30, page 67, shows the drawing of the drillator.
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Figure 1.30: drawing of the drillator

Details

Quantity 1 ;

Material PLA ;

Manufacturing Instructions

1. 3d print the drillator the files are in the folder named 3d-print-files.
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1.7.2 tensionator

This section explains how to build the shaped tool called the tensionator for the assembly
of the m2 machine.

Drawing The figure 1.31, page 68, shows the drawing of the tensionator with all its
elements.

weight

rope

pulley

clamps

Figure 1.31: tensionator and its elements
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Table 1.10: Parts list of tensionator

Qty Part Description Material
1 pulley D50 mm -
1 colson 4 mm -
2 rope - -
1 weight 17 kg -
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female junction

glue

sleeve

tube

2.1.1 Parts list

Table 2.1: Parts list of the rod

Qty Part Description Material
1 tube 20/18,length: 250 mm carbon
1 female junction google : pool cue junction brass
1 sleeve 3D printed PLA
1 glue resin, hardner, graphite powder
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2.1.2 Drawing

See Figure 2.1, page 73.
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Figure 2.1: Drawing of the rod parts

2.1.3 Manufacturing Instructions

Required Tools and Components

• 1x carbon tube length: 500 mm ;

• 1x paper ;

• 1x tape ;

• 1x handsaw ;

• 1x perpendiculator ;

• 1x drillator ;

• 1x 5mm drill bit ;

• 1x driller ;
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• 1x sandpaper ;

• 1x 3D printer ;

• 1x PLA filament ;

• 2x female junction ;

• 1x file ;

tube

1. Scribe a mark at the exact middle of the carbon tube.

2. Wrap a piece of paper around the tube and secure it with tape (to guide the cut).

3. Use a handsaw to cut the tube into two equal parts.

4. Make both ends of each tube perpendicular using the perpendiculator tool.

5. Remove the sharp edges with sandpaper.

6. Drill the 6 holes using the driller and the drillator tool (refer to the Drawing section).

7. Remove the sharp edges again with sandpaper.

sleeve

1. 3D print the part using the files located in the 3d-print-files directory.

2. Chamfer the edges using a file.

3. Insert the female junction into the sleeve and gently push it into the tube. Adjust if
there is too much friction or too large a gap.

female junction

1. File the three 5/1.5mm flats—see dimensions in the Drawing section.

2.1.4 Assembly Instructions

Required Tools and Components

• 1x hot glue ;

• 1x male junction ;

• 1x tape ;

• 1x scale ;

• 1x glue :

– resine:
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Brand ? ;

Type ?.

– hardner:

Brand ? ;

Type ?.

• 1x graphite powder :

Brand Suter Kunstoff AG ;

Type West Graphit-Pulver 423.

• 1x clamp ;

• 1x piano wire ;

• 1x oven ;

• 1x perpendicalor.

1. Screw the male junction into the female junction.

2. Seal the hole with hot glue.

3. Trim any excess hot glue using a scalpel.

4. Unscrew the male junction.

5. Thoroughly clean the outside and top of the female junction with acetone.

6. Seal the hole with tape.

7. Using a scalpel, carefully cut the tape around the female junction.

8. Insert the female junction into the sleeve, ensuring the flat side aligns with the canals
inside the sleeve.

9. Push the assembly into the tube until the female junction is aligned with the end of
the tube. Use a ruler for accuracy. Press on the tape — it’s normal for the female
junction to move slightly inward due to the tape’s thickness.

10. Wrap tape around the end of the tube, with the tape’s edge extending about 1 mm
above the end of the tube.

11. To glue two female junctions, prepare the following mixture:

• 1.5 g of hardener ;

• 3.75 g of resin ;

• 1.125 g of graphite powder.

12. Prepare glue, as described in the shaped-parts section, and mix it with graphite pow-
der.
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13. Use a clamp to hold the tube vertically.

14. Pour the glue mixture above the tape, letting it slightly overflow past the end of the
tube.

15. Use piano wire to enter each canal of the sleeve, removing any bubbles and ensuring
glue flows properly into the canals.

16. Let the glue set for 2 hours.

17. After 2 hours, check the level of the composite. Add more if necessary.

18. Allow to cure for 24 hours, or place in an oven to accelerate curing.

19. Use the perpendiculator to grind the end of the tube until the tape sealing the female
junction is removed (you should see a shiny ring appear).

20. Repeat the same steps for the other end of the tube.
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2.2 suction cup dildo adapter

This section explain how to build the suction cup dildo adapter for the m2 machine.

bolt
washer

suction cup dildo adapter bolt

male-junction

suction cup dildo adapter nut

washernut

2.2.1 Parts list

Table 2.2: Parts list of suction-cup-adapter

Qty Part Description Material
1 suction cup dildo adapter nut 3D printed PLA
1 suction cup dildo adapter bolt 3D printed PLA
1 male junction google : pool cue junction brass

continued on next page ...
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... continued
Qty Part Description Material
1 bolt M4 x 30 mm stainless steel
1 nut M4 brass
2 washer M4 stainless steel

2.2.2 Drawing

See Figure 1.27, page 51.
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Figure 2.2: Drawing of the suction cup dildo adapter parts

2.2.3 Manufacturing Instructions

Required Tools and Components

• 1x 3D printer ;

• 1x CAD software (to ajuste M10 tap in case) ;

• 1x PLA ;

• 1x STL file suction cup dildo adapter nut ;
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• 1x STL file suction cup dildo adapter bolt ;

• 1x STL file drillator ;

• 1x STL file sample ;

• 1x male junction ;

• 1x bolt ;

• 2x washer ;

• 1x nut ;

• 1x file ;

• 1x 3.2 mm drill bit ;

• 1x chamfer mill ;

• 1x M4 tap ;

• 1x tap wrench ;

• 1x boltdriver ;

• 1x drill press ;

• 1x driller ;

• 1x water pump pliers ;

• 1x allen key ;

• 1x threaderlock glue ;

• 1x bench vise.

1. Skip the next three steps if all 3D printers used print with the same accuracy as an
Ultimaker.

2. 3D print the sample.

3. Test if the M10 tap fits into the sample.

4. Adjust the M10 tap size on the suction cup dildo adapter nut, suction cup dildo
adapter bolt, and drillator 3D models as needed.

5. Remark : Before printing the suction cup dildo adapter nut and the suction cup
dildo adapter bolt, adjust the starting position of the M4 thread. The drillator was
originally designed for a 2mm male junction, but since the actual male junction is
located at 0.5 mm, I had to shift the thread start by 0.5 mm to compensate. themale
juction was not at 2mm but at 2.5mm. 3D print the suction cup dildo adapter nut,
suction cup dildo adapter bolt, and drillator.



80 CHAPTER 2. M2 ACCESSORIES

6. Screw the male junction into the drillator (the large diameter with a width of 2mm
should be flush against the reference plane). Use water pump pliers.

7. On a drill press, drill a 3.2mm hole.

8. File or chamfer the hole.

9. Tap an M4 thread.

10. Assemble the male junction and suction cup dildo adapter bolt with the bolt.
Don’t forget to apply thread locker.
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2.3 tenga adapter

male junction

tenga adapter

glue

screw

washer

Figure 2.3: m2 accessories tenga-adapter parts

2.3.1 Parts list

Table 2.3: Parts list of tenga-adapter

Qty Part Description Material
1 tenga adapter 3D Printed PLA
1 male junction M10 x 39.3 mm PLA
1 glue casted epoxy and grafite powder
2 screw M4 x 25 mm Torx flat head screw stainless
1 washer M7 x 13 x 0.5 mm stainless steel
1 drillator 3D Printed PLA
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2.3.2 Drawing

See Figure 2.4, page 82.
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Figure 2.4: Drawing of the tenga adapter parts

2.3.3 Required Tools and Components

• 1x 3D printer ;

• 1x PLA ;

• 1x STL file (tenga adapter) ;

• 1x STL file (drillator) ;

• 1x male junction ;

• 1x female junction ;

• 1x screwdriver ;

• 1x 3.2 mm drill bit ;

• 1x 4.2 mm drill bit ;
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• 1x chamfer cutter ;

• 1x M4 tap ;

• 1x left-hand tap ;

• 1x drill press ;

• 1x driller ;

• 1x file ;

• 1x tape ;

• 1x cutter ;

• 1.5 g of hardener ;

• 3.75 g of resin ;

• 1.125 g of grafite powder ;

• 1x wood chisel.

2.3.4 Manufacturing Instructions

See also video : https://youtu.be/Vnh40WeMOiQ

1. 3D print the drillator.

2. 3D print the Tenga adapter.

3. Drill a 4.2 mm hole in the Tenga Fleshlite.

4. Insert the male junction into the female junction.

5. Using a drill press, drill a 3.2 mm hole.

6. Tap an M4 thread into the hole.

7. File three flat surfaces on the M10 thread.

8. Wrap tape around the M4 thread.

9. Trim the tape using a cutter.

10. Insert the male junction into the Tenga adapter.

11. Prepare the glue mixture:

• 1.5 g of hardener;

• 3.75 g of resin;

• 1.125 g of graphite powder.

12. Pour the glue into the assembly.

https://youtu.be/Vnh40WeMOiQ
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13. Remove any excess glue from the top of the male junction.

14. Assemble the Tenga Fleshlite using the screw.
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Figure 3.1: power unit p parts

3.1 Parts list
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Table 3.1: Parts list of power unit p

Qty Part Description Material
1 housing 78 x 47 x 240 mm aluminium
1 power supply 110V/220V 36V 180W -
1 driver G201X Digital Step Drive -
1 microcontroller ESP32 30 pins -
1 voltage regulator LM2596 -
1 motor socket amphenol female 5 poles aluminium
1 remote socket 34 x 28 x 18 mm RJ45 -
1 cable gland 17 x 34 x 8 mmm -
1 motor plug amphenol male 5 poles aluminium
1 power supply cable 3-core 0.5mm2 length : 2 m -
1 power supply plug depends on country 110 V or 220 V -
1 motor cable 4-cores 0.5mm2 length : 1 m 1

1 wire 0.5mm2 length : 1 m cooper
1 wire 0.75mm2 length : 0.50 m cooper

1in case the motor is not supplied with its own
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3.2 housing

rivet

base

side socket side

top

Figure 3.2: housing parts

3.2.1 Parts list

Table 3.2: Parts list of housing

Qty Part Description Material
1 base U 75 x 44 x 1.5 length : 240 mm aluminium
1 top U 78 x 10 x 1.5 length : 240 mm aluminium
1 side socket U 43 x 10 x 1.5 length : 70 mm aluminium
1 side U 43 x 10 x 1.5 length : 70 mm aluminium
8 rivet 3 x 8 mm aluminium
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3.2.2 Drawing
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3.3 power supply

Figure 3.5: power supply parts

3.3.1 Parts list

Table 3.3: Parts list of power supply

Qty Part Description Material
1 power supply AC/DC WXDC2416 220-110/36V -
1 ring connector M3 -
1 lock washer 3.3 x 5.1 x 0.8 stainless steel
4 spacer 3.2 x 7 x 5 aluminium
4 washer 3.2 x 7 x 0.5 stainless steel
4 rivet 3 x 14 mm aluminium
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3.3.2 Drawing

34
,5

O
4,2

O
3,2

0,8
5,1

O

3,3O

115 66

105,8

55
,7

3,2O 7O

5

3,2O

0,5

O
7

3
O

14

power supply

ring connector
lock washer

spacer
washer rivet

Figure 3.6: power unit p/housing/power supply/parts drawing
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3.4 driver

Figure 3.7: driver parts

3.4.1 Parts list

Table 3.4: Parts list of driver

Qty Part Description Material
1 driver G201X Digital Step Drive -
4 washer 3.2 x 7 x 0.5 stainless steel
4 rivet 3 x 10 mm aluminium
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3.4.2 Drawing
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Figure 3.8: power unit p/housing/driver parts drawing
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3.5 microcontroller

Figure 3.9: microcontroller parts

3.5.1 Parts list

Table 3.5: Parts list of microcontroller

Qty Part Description Material
1 microcontroller ESP32 30 pins -
1 support 3D printed PLA
2 screw 2 x 8 brass
2 washer 3.2 x 7 x 0.5 stainless steel
2 rivet 3 x 12 mm aluminium
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3.5.2 Drawing
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Figure 3.10: power unit p/housing/microcontroller parts drawing
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3.6 voltage regulator

Figure 3.11: voltage regulator parts

3.6.1 Parts list

Table 3.6: Parts list of voltage regulator

Qty Part Description Material
1 voltage regulator LM2596 -
2 spacer 3.2 x 7 x 3 nylon
2 rivet 3 x 8 mm aluminium
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3.6.2 Drawing
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Figure 3.12: power unit p/housing/voltage regulator parts drawing
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3.7 motor socket

motor socketnut

gasket

screw

Figure 3.13: motor socket parts

3.7.1 Parts list

Table 3.7: Parts list of motor socket

Qty Part Description Material
1 motor socket amphenol female 5 poles aluminium
1 gasket 32.5 x 32.5 x 1.5 rubber
4 screw M3 x 12 mm stainless steel
4 nut M3 stainless steel
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3.7.2 Drawing
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Figure 3.14: power unit p/housing/motor socket parts drawing
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3.8 remote socket

Figure 3.15: remote socket parts

3.8.1 Parts list

Table 3.8: Parts list of remote socket

Qty Part Description Material
1 remote socket 34 x 28 x 18 RJ45 -
1 support 3D printed PLA
4 screw 2 x 10 mm brass
2 screw 3 2.9 x 10 mm stainless steel
2 connector 24.3 x 7 x 4 mmm 9 poles -
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3.8.2 Drawing
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Figure 3.16: power unit p/housing/remote socket parts drawing
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3.9 cable gland

cable gland

nut

Figure 3.17: cable gland parts

3.9.1 Parts list

Table 3.9: Parts list of cable gland

Qty Part Description Material
1 cable gland 17 x 34 x 8 mm nylon
1 nut 17 x 5 mm nylon
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3.9.2 Drawing
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Figure 3.18: power unit p/housing/cable gland parts drawing
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3.10 motor plug

Figure 3.19: motor plug

3.10.1 Parts list

Table 3.10: Parts list of motor plug

Qty Part Description Material
1 motor plug amphenol male 5 poles aluminium
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3.10.2 Drawing
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Figure 3.20: power unit p/housing/motor plug drawing
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3.11 Wiring

3.11.1 Wiring diagram

VIN GND D13 D12 D14D27 D26 D25 D33 D32 D35

microcontroller
3V3 GND

E

A

B C

D

motor

CLKDTSW+

GND

CLKDT
SW+GND

IN- IN+

OUT- OUT+

E
A

BC

D

driver

1
2

3
4

5
6

7
8

9
10

11
12 

1 2 3 4 5 6 7 8 9

VERY IMPORTANT: ATTACHE THE GROUND ON THE HOUSING / BASE

voltage regulator

power supply plug
      (110V or 220V)

remote socket

connector

remote cable

motor socket motor plug

motor cable (if motor doesn't have one)

encoder stroke encoder speed

power supply cable

P

N

LM42P wiring diagram
     power unit p

power supply

Figure 3.21: Wiring diagram

3.11.2 Parts list

Table 3.11: Parts list of power unit p

Qty Part Description Material
1 power supply cable 3 poles 0.75mm2 length : 2 m -
1 power supply plug depends on country 110 V or 220 V -
1 motor cable 4 poles 0.5mm2 length : 1 m2

1 wire 0.5mm2 length : 1 m cooper
1 wire 0.75mm2 length : 0.50 m cooper

2in case the motor is not supplied with its own
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Required Tools and Components

• 1x wire cutter ;

• 1x wire stripper ;

• 1x terminal crimping tool ;

• 1x multimeter ;

• 1x soldering iron ;

• 1x solder ;

• 1x gauge ;

• 1x screwdriver 0 ;

• 1x rivet gun ;

• 1x water pump pliers ;

• 1x electrical tape.

3.11.3 Wiring Instructions

The lengths and cross-sectional areas of the wires are listed in table 3.12, page 109.

1. File the bottom of the base (only the part where the red framed hole is) so that the
grounding contact faces well. This operation is not necessary if you are using non an-
odized sheets (anodized surfaces are none-conductive). See Figure 3.22, page 107.

Figure 3.22: Make the housing base conductive

2. Strip the power supply cable 3 cores at 10cm.

3. Tighten the ring connector on the ground wire (yellow).

4. Fix the cable gland to the base.
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5. Tighten cable gland.

6. Control the power supply : control the voltage of the output of the power supply
with a voltmeter. It should be 36V.

7. Install the power supply in the base, ensuring that the ground connection is correctly
made (see Figure 3.23, page 108).

Figure 3.23: Connect the power supply ground to the base and power supply cable ground

8. Connect and tighten the phase and neutral wires to the 36V ”IN” terminals of the
power supply.

9. Connect the power supply plug to the power supply cable.

10. Use a multimeter (in resistance mode) to verify that the ground of the power supply
plug is properly connected to the base.

11. Solder the four wires to the corresponding pins on the voltage regulator :

• Connect the wire to IN+ (input positive).

• Connect the wire to IN- (input negative).

• Connect the wire to OUT+ (output positive).

• Connect the wire to OUT- (output negative).

12. Install the voltage regualator in the base.

13. Adjust voltage regulator voltage :

(a) Connect the voltage regulator IN to the power supply OUT ;

(b) Connect the voltmeter to voltage regulator OUT
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14. Solder the four wires to the motor socket.

15. Install all other components in the base.

16. Wire them properly (see Terminals Connection and Wires details in Table 3.12, page 109
and Wiring diagram 3.21, 106).

17. Wire the motor plug :

(a) Strip the outer cable sheath over a length of 3 cm.

(b) Strip the four inner wires and solder them as required.

(c) At 5 cm from the edge, wrap 10 layers of electrical tape around the cable.

(d) Assemble the plug and tighten the flange.

3.11.4 Terminals Connections and Wires details

Table 3.12: Connections and wire details

Connections wire length [cm] wire section [mm2]
D35 microcontroller - 1 connector 9 0.25
D32 microcontroller - 2 connector 9 0.25
D33 microcontroller - 9 driver 9 0.25
D25 microcontroller - 8 driver 9 0.25
D26 microcontroller - 3 connector 9 0.25
D27 microcontroller - 4 connector 9 0.25
D14 microcontroller - 5 connector 9 0.25
D13 microcontroller - 6 connector 9 0.25
10 driver - 7 connector 15 (don’t cut) 0.25
10 driver - GND microcontroller 93 0.5
3 driver - A motor socket 15 0.75
4 driver - B motor socket 15 0.75
5 driver - C motor socket 15 0.75
6 driver - D motor socket 15 0.75
8 connector - VIN microcontroller ? 0.25
OUT- voltage regulator - GND microcontroller 7 0.5
OUT+ voltage regulator - VIN microcontroller 12 0.5
IN+ voltage regulator - OUT+ power supply 16 0.5
IN- voltage regulator - OUT- power supply 15 0.5

3Wired according to precedent and tightly bundled within the 10 driver
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3.12 Firmware

After all components have been installed and wired inside the housing, it is time to upload
the firmware to the microcontroller.

3.12.1 Code

The firmware source code is located in the code directory. A portion of the firmware code is
shown below.

To upload the firmware, please follow the steps described in Appendix B (page 135).

1 // speed rotary encoder

2 #define ROTARY_ENCODER_A_PIN 27 //CLK

3 #define ROTARY_ENCODER_B_PIN 26 //DT

4 #define ROTARY_ENCODER_BUTTON_PIN 32 //SW

5 #define ROTARY_ENCODER_STEPS 4

6 #define ROTARY_ENCODER_ACCELERATION 2000 //30000 3000

7 AiEsp32RotaryEncoder rotaryEncoder = AiEsp32RotaryEncoder(

ROTARY_ENCODER_A_PIN , ROTARY_ENCODER_B_PIN ,

ROTARY_ENCODER_BUTTON_PIN , -1, ROTARY_ENCODER_STEPS);

8

9 // stroke rotary encoder

10 #define ROTARY_ENCODER2_A_PIN 13 //CLK

11 #define ROTARY_ENCODER2_B_PIN 35 //DT

12 #define ROTARY_ENCODER2_BUTTON_PIN 14 //SW

13 #define ROTARY_ENCODER2_STEPS 4

14 #define ROTARY_ENCODER2_ACCELERATION 7000

15 AiEsp32RotaryEncoder rotaryEncoder2 = AiEsp32RotaryEncoder(

ROTARY_ENCODER2_A_PIN , ROTARY_ENCODER2_B_PIN ,

ROTARY_ENCODER2_BUTTON_PIN , -1, ROTARY_ENCODER2_STEPS);

16

17 void IRAM_ATTR readEncoderISR ()

18 {

19 rotaryEncoder.readEncoder_ISR ();

20 rotaryEncoder2.readEncoder_ISR ();

21 }

22

23 // IO pin assignments

24 const int MOTOR_STEP_PIN = 33;

25 const int MOTOR_DIRECTION_PIN = 25;

26

27 // Speed and stroke settings

28 const int MIN_SPEED = 2000; //set min speed in us/step

29 const int MAX_SPEED = 10; // no diff 5 and 20 5 10 15 25 45 speed/

accelration for 1kg toy: 45/320000

30 // higher the acceleration and lower value

of speed can be set to be

31 // more speedy

32 const int MIN_STROKE = 10; // 10 vibro_stroke = 10

33 const int MAX_STROKE = 4800; //4850 4650 4600 4500 4000

34



3.12. FIRMWARE 111

35 // Motor acceleration

36 int MOTOR_ACCELERATION = 320000; // 640000 for small toy 850000

decroche 640000 320000; // speed/acceleration for 1kg toy:

45/320000

37

38 FastAccelStepperEngine engine = FastAccelStepperEngine ();

39 FastAccelStepper *stepper = NULL;

40

41 long target = 0; // it’s the target

42 int previousDirection = 1;

43 bool stopped = true; // machine stopped

44 unsigned long lastButtonPress = 0; // avoid rebounce when button is

pressed

45 bool green = false; // green side of the machine is used

46 bool red = false; // red side of the machine is used

47 const int GAP = 50; // gap between the end of machine and mobile part

;

48

49 void setup() {

50 Serial.begin (115200);

51 pinMode(ROTARY_ENCODER_A_PIN , INPUT_PULLUP);

52 pinMode(ROTARY_ENCODER_B_PIN , INPUT_PULLUP);

53

54 pinMode(ROTARY_ENCODER2_A_PIN , INPUT_PULLUP);

55 pinMode(ROTARY_ENCODER2_B_PIN , INPUT_PULLUP);

Listing 3.1: Partial code: firmware.ino



112 CHAPTER 3. POWER UNIT P



Chapter 4

remote control

Figure 4.1: remote control parts

4.1 Parts list

Table 4.1: Parts list of remote control

Qty Part Description Material
1 housing 3D printed PLA
1 cover 3D printed PLA
2 encoder with switch
2 knob 14 x 16.5 mm aluminium
1 cable 3 x 2500 mm LAN RJ45 -
1 cable clamp 2.5 mm nylon
10 screw 2 x 10 mm brass

continued on next page ...

113
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... continued
Qty Part Description Material
1 stroke inscription molded into cavity pigmented white epoxy
1 speed inscription molded into cavity pigmented white epoxy
1 min inscription molded into cavity pigmented green epoxy
1 max inscription molded into cavity pigmented red epoxy
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4.2 Drawing
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Figure 4.2: remote control parts drawing
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Shaped Tools
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In this chapter, I introduce the tools required to build all the machines described in this
building plan. I present the perpendiculator—a tool used to make the ends or faces of a
tube, or any part, perfectly perpendicular.
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A.1 perpendiculator
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Worldmap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
In this section I introduce how to build the perpendiculator. This tool has two assemblies

the plane and the slider. They have both a paragraph in which all details are explained. In
the paragraph Assemblies the whole tool are assembled with the sub-assemblies plane and
slider. And in the paragraph Normalized parts are showed all the normalized parts which
are used for the plane and the slider (for example wooden glue, nails).

A.1.1 Roadmap

In this section we can find the roadmap to build the perpendiculator. It’s not necessary to
follow straight all these points after another, but I think it’s the most logical to do it like this :

1. prepare all stuff in the Parts-list with the tools showed in the Tools-list ;

2. assemble the slider ;

3. assemble the base.

A.1.2 Parts list

In this section we can find the whole list of parts that the perpendiculator needs, like :

• 1x base size 133x400x19 in MDF ;

• 1x rectangular-wooden-list size 15x20x1000 in beech for :

– 2x guide.

• 1x sandpaper ;

• 1x face-1 size 100x250x16 in MDF ;

• 1x face-2 size 116x250x16 in MDF ;

• 1x nails (box) size 1.4x30 ;

• 1x wooden glue ;

• 1x amidon glue.
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A.1.3 Tools list

In this section we can find the list of tools that we need to build the perpendiculator, like :

• 1x hammer ;

• 1x drill press ;

• 1x 1.4mm diameter drill ;

• 2x clamps ;

• 1x ruler ;

• sandpager.

A.1.4 Shaped parts

In this paragraph we can find all the shaped parts of the perpendiculator, like :

• base ;

• guide ;

• sandpaper ;

• face-1 ;

• face-2.

base

Here is shown the information for the shaped part base.

Roadmap

1. order in a carpentry.

That’s all for this part.

Drawing See figure A.1, page 121
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Figure A.1: Shaped part : base for perpendiculator tool

quantity 1 ;

material MDF ;

provider carpentry ;

price ?.

guide

This section shows how to build the guide of the perpendiculator tool.

Roadmap

1. order the rectangular-wooden-list see section A.1.5, 127 ;

2. ask at the carpentry to cut it at the good length (see the length on the figure A.2,
page 122) ;

3. drill the holes with diameter 1.4mm (see figure A.2, page 122 for the positions).

Drawing See figure A.2, page 122
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380
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Figure A.2: Shaped part : guide for perpendiculator tool

quantity 2 ;

material beech ;

provider ironmongery ;

price ? .

sandpaper

Drawing See figure A.3, page 123
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Figure A.3: Shaped part : sandpaper for perpendiculator tool

quantity 1 ;

material emery granularity : 80 ;

provider ironmongery ;

price ?.
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face-1

Roadmap

1. order the part in a joinery see figure A.4, page 124 for dimensions.

250

10
0

16

Figure A.4: Shaped part : face-1-outsourcing for perpendiculator tool

Drawing This is how the face-1 looks at the end. See figure A.5, page 125
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Figure A.5: Shaped part : face-1 for perpendiculator tool

quantity 1 ;

material MDF ;

provider joinery ;

price ?.
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face-2

Roadmap

1. order the part in a joinery see figure A.6, page 126 for dimensions ;
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Figure A.6: Shaped part : face-2-outsourcing for perpendiculator tool

2. drill the holes for dimension of the hole and positions see figure A.7, page 127.

Drawing See figure A.7, page 127
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Figure A.7: Shaped part : face-2 for perpendiculator tool

quantity 1 ;

material MDF ;

provider ironmongery ;

price ?.

A.1.5 Normalized parts

In this paragraph the normalized parts of the perpendiculator are showed. Like :

• sandpaper ;

• nails.

rectangular-wooden-list

Here are some information of the rectangular-wooden-list which are used to build the
perpendiculator.

Drawing See figure A.8, page 128
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1000

20

15

Figure A.8: Normalized part : rectangular-wooden-list for perpendiculator tool

quantity 1 ;

material beech ;

provider ironmongery ;

price 5.20frs.

sandpaper

Here are some information of the sandpaper which are used for the perpendiculator.

Size ? ;

Provider any ironmongery ;

Price ?

nails

Here are some information of the nails which are used to build the perpendiculator.

Drawing See figure A.9, page 129
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1,4

30

Figure A.9: Normalized part : nail for perpendiculator tool

quantity 1 box ;

material steel ;

provider ironmongery ;

price ?.

amidon-glue

quantity a bit ;

provider any ironmongery ;

price ?
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A.1.6 Assemblies

plane

slider

After built all the Shaped-parts and get allNormalized-parts, it’s time now to assemble
the sub-assemblies :

• plane ;

• slider.

Roadmap

1. assemble the plane ;

2. assemble the slider ;

3. assemble the perpendiculator with plane and slider.
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plane

guide

sandpaper

base

nails

In this section we explain how to assemble the plane which is a sub-assemblie of the
perpendiculator.

Worldmap

1. with amidon glue glue the sandpaper at the right position (see figure A.10, page 132) ;
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40
40

Figure A.10: position of the sandpaper on the base

2. align the guide to the edge of the base ;

3. once well aligned, clamp with two clamps ;

4. put the nails in the holes of the guide ;

5. hammer the nails maybe 2 or 3mm inside the base ;

6. make a mark to know the direction of guide on the base ;

7. remove the clamps and the guide from the base ;

8. put some wooden glue on the guide ;

9. then align the guide with the holes made with the nails in the base ;

10. hammer the nails deep into the base to tight the guide ;

11. repeat these steps for the second guide ;
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slider

face-2

face-1

nails

In this section we explain how to assemble the slider which is a sub-assemblie of the
perpendiculator.

Worldmap

1. put the nails in the holes of face-2 ;

2. align the face-2 on the face-1 ;

3. press both parts with a clamp ;

4. hammer the nails 3 to 4mm into the face-1 ;

5. remove the clamps and unjoin face-1 and face-2 ;

6. put some wooden-glue on the face-2 ;

7. join both part again taking care that that the nails go into the hole of 3 to 4mm depth
done at the previous point ;

8. hammer the whole length of the nails so that both parts are pressed for glueing.
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Appendix B

How to upload firmware

1. Install the Arduino IDE from https://www.arduino.cc/en/software.

2. In the Arduino IDE, go to File → Preferences, and in the “Additional Board Manager
URLs”, add:

https://raw.githubusercontent.com/espressif/arduino-esp32/

gh-pages/package esp32 index.json

3. Go to Tools → Board →¿ Boards Manager, search for esp32, and install the board
package by Espressif Systems.

4. Connect your ESP32 board via USB and select the correct board from Tools → Board,
e.g., ESP32 Dev Module.

5. Select the correct COM port under Tools → Port.

6. Open the firmware source code from the code directory.

7. Click the Upload button. If it fails to connect, press and hold the BOOT button on
the ESP32 during the upload process.
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